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Question Number : 1 Question Id : 2549896561 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Files and folders deleted from the hard disk of a computer get stored temporarily in ________ .
Options :
1.  My Computer
2.  Recycle Bin
3.  Current Documents
4.  RAM
  
Question Number : 1 Question Id : 2549896561 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



कं�ूटर की हाड� िड� से िडलीट की गई फ़ाइल� और फ़ो�स� अ�ायी �प से कहाँ �ोर हो जाती ह�?
Options :
1.  माइ कं�ूटर (My Computer)

2.  रीसायकल िबन (Recycle Bin)

3.  कर� डॉ�ुम�ट्स (Current Documents)
4.  RAM

  
Question Number : 2 Question Id : 2549896929 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT contained in Uniform Resource Identifier?
Options :
1.  Scheme
2.  Authority
3.  Display
4.  Query
  
Question Number : 2 Question Id : 2549896929 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा, यूिनफ़ॉम� �रसोस� आइड��िटफ़ायर (Uniform Resource Identifier) म� शािमल नही ंहै?
Options :
1.  �ीम (Scheme)

2.  अथॉ�रटी (Authority)

3.  िड��े (Display)

4.  �ेरी (Query)
  
Question Number : 3 Question Id : 2549896951 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A computer works on a/an _______ number system.
Options :



1.  binary
2.  octal
3.  decimal
4.  hexadecimal
  
Question Number : 3 Question Id : 2549896951 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक कं�ूटर एक ________ सं�ा �णाली (number system) पर काम करता है।
Options :
1.  बाइनरी (binary)

2.  ऑ�ल (octal)

3.  डेिसमल (decimal)

4.  हे�ाडेिसमल (hexadecimal)
  
Question Number : 4 Question Id : 2549897538 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the keyboard shortcut to move to the next suggestion with Automatic Word Completion in OpenOffice Writer 3?
Options :
1.  Tab
2.  Ctrl + Tab
3.  Ctrl + Alt + Tab
4.  Shift + Tab
  
Question Number : 4 Question Id : 2549897538 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ओपनऑिफस राइटर 3 (OpenOffice Writer 3) म�, ऑटोमेिटक वड� कं�ीशन के साथ अगले सजेशन (suggestion) पर जाने के िलए कीबोड� शॉट�कट �ा है?
Options :
1.  Tab
2.  Ctrl + Tab



3.  Ctrl + Alt + Tab
4.  Shift + Tab

  
Question Number : 5 Question Id : 2549897612 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
DVD is an example of ______.
Options :
1.  an optical disk
2.  a magnetic disk
3.  a magnetic tape
4.  a flash device
  
Question Number : 5 Question Id : 2549897612 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
डीवीडी (DVD) '___________' का एक उदाहरण हैI
Options :
1.  ऑि�कल िड�
2.  मै�ेिटक िड�
3.  मै�ेिटक टेप
4.  �लैश िडवाइस
  
Question Number : 6 Question Id : 2549898474 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following function of MS-Excel 2019 returns a reference to a range that is a specified number of rows and columns from a cell or range of
cells?
Options :
1.  OFFSET
2.  REFOFFSET
3.  OFFSETREF



4.  OFFSETREFR
  
Question Number : 6 Question Id : 2549898474 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 का िन�िल�खत म� से कौन-सा फं�न, एक र�ज का रेफर�स �रटन� करता है जो िकसी सेल या सेलो ंके र�ज से पं��यो ं(rows) और �ंभो ं(columns) की
एक िनिद�� सं�ा है?
Options :
1.  OFFSET
2.  REFOFFSET
3.  OFFSETREF
4.  OFFSETREFR
  
Question Number : 7 Question Id : 2549898897 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following device can be used as both input and output device?
Options :
1.  Keyboard
2.  Touch Screen
3.  Plotter
4.  Speakers
  
Question Number : 7 Question Id : 2549898897 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से िकस िडवाइस का उपयोग इनपुट और आउटपुट िडवाइस दोनो ंके �प म� िकया जा सकता है?
Options :
1.  कीबोड�
2.  टच �ीन
3.  �ॉटर
4.  �ीकस�



  
Question Number : 8 Question Id : 2549899357 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Dot matrix is a type of a ______.
Options :
1.  scanner
2.  keyboard
3.  mouse
4.  printer
  
Question Number : 8 Question Id : 2549899357 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
डॉट-मैिट� � एक______ का �कार है।
Options :
1.  �ैनर
2.  कीबोड�
3.  माउस
4.  ि�ंटर
  
Question Number : 9 Question Id : 25498922524 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is/are true with reference to mail merge in MS-Word 365?

(i) You cannot add attachments while sending individual messages to each email address using mail merge.
(ii) You can include links while sending individual message to each email address using Mail merge.
Options :
1.  Only (i)
2.  Only (ii)
3.  Both (i) & (ii)
4.  Neither (i) nor (ii)



  
Question Number : 9 Question Id : 25498922524 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 365 म�, मेल मज� के संदभ� म� िन�िल�खत म� से कौन-सा/से कथन स� है/ह�?

(i) आप मेल मज� का उपयोग करके ��ेक ईमेल एड� ेस पर अलग-अलग मेसेज भेजते समय अनुल�क (attachments) ऐड नही ंकर सकते ह�।
(ii) आप मेल मज� का उपयोग करके ��ेक ईमेल एड� ेस पर अलग-अलग मेसेज भेजते समय िलंक शािमल कर सकते ह�।
Options :
1.  केवल (i)

2.  केवल (ii)

3.  (i) और (ii) दोनों
4.  न तो (i) और न ही (ii)
  
Question Number : 10 Question Id : 25498929854 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a type of a barcode reader?
Options :
1.  CCD scanner
2.  Omni-directional barcode scanner
3.  Pen wand
4.  Inkjet reader
  
Question Number : 10 Question Id : 25498929854 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा बारकोड रीडर का एक �कार नही ंहै?
Options :
1.  CCD �ैनर
2.  ओमनी-डायरे�नल बारकोड �ैनर
3.  पेन-वंड



4.  इंकजेट रीडर
  
Question Number : 11 Question Id : 25498930070 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following domains is used to map an address to a name when a server request has received a request from a client to do a task?
Options :
1.  Domain Name System
2.  Network Topology
3.  Network Interface Card 
4.  Uniform Resource Locator
  
Question Number : 11 Question Id : 25498930070 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब सव�र �र�े� को िकसी �ाइंट से कोई काय� करने का �र�े� �ा� होता है, तो िकसी एड� ेस को नाम से मैप करने के िलए िन�िल�खत म� से िकस डोमेन का उपयोग
िकया जाता है?
Options :
1.  डोमेन नेम िस�म
2.  नेटवक�  टोपोलॉजी
3.  नेटवक�  इंटरफ़ेस काड�
4.  यूिनफ़ॉम� �रसोस� लोकेटर
  
Question Number : 12 Question Id : 25498930304 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is an optical storage device that uses a laser to read and write to the disk using a red laser beam?
Options :
1.  Magnetic disk
2.  CD
3.  Blu-ray disk
4.  Magnetic tape



  
Question Number : 12 Question Id : 25498930304 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा एक ऑि�कल �ोरेज िडवाइस है जो लाल लेजर बीम का उपयोग करके िड� पर पढ़ने और िलखने के िलए लेजर का उपयोग करता है?
Options :
1.  मै�ेिटक िड�
2.  सीडी (CD)

3.  �ू-रे िड�
4.  मै�ेिटक टेप
  
Question Number : 13 Question Id : 25498930892 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Drum and flatbed are types of _______.
Options :
1.  readers
2.  scanners
3.  printers
4.  plotters
  
Question Number : 13 Question Id : 25498930892 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ड� म और �ैटबेड _______ के �कार ह�।
Options :
1.  रीडस�
2.  �ैनस�
3.  ि�ंटस�
4.  �ॉटस�
  
Question Number : 14 Question Id : 25498930924 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes



Correct Marks : 1 Wrong Marks : 0
Which of the following network topologies has all the computers connected through a single cable?
Options :
1.  Mesh topology
2.  Bus topology
3.  Ring topology
4.  Star topology

  
Question Number : 14 Question Id : 25498930924 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से िकस नेटवक�  टोपोलॉजी म� सभी कं�ूटर एक ही केबल से जुड़े �ए होते ह�?
Options :
1.  मेश टोपोलॉजी
2.  बस टोपोलॉजी
3.  �रंग टोपोलॉजी
4.  �ार टोपोलॉजी
  
Question Number : 15 Question Id : 25498931006 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a small electronic circuit printed on a chip that contains many of its own circuit elements (e.g. transistors, diodes, resistors, etc.)?
Options :
1.  Vacuum tube
2.  Integrated circuit
3.  Microprocessor
4.  Magnetic drum
  
Question Number : 15 Question Id : 25498931006 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा, एक िचप पर ि�ंट िकया गया एक छोटा इले�� ॉिनक सिक� ट है िजसम� इसके कई सिक� ट अवयव (जैसे ट� ांिज�र, डायोड, रेिस�स�, आिद) होते ह�?



Options :
1.  वे�ूम �ूब
2.  इंटी�ेटेड सिक� ट
3.  माइ�ो�ोसेसर
4.  मै�ेिटक ड� म
  
Question Number : 16 Question Id : 2549899534 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
By default, MS-Excel 2019 names a worksheet as_______.
Options :
1.  Sheet1
2.  Sheet_1
3.  Sheet-1
4.  Sheet@1
  
Question Number : 16 Question Id : 2549899534 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िडफ़ॉ� �प से, MS-Excel 2019, एक वक� शीट को _______ नाम देता है।
Options :
1.  Sheet1
2.  Sheet_1
3.  Sheet-1
4.  Sheet@1
  
Question Number : 17 Question Id : 2549899586 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which computer program sequences print jobs by temporarily storing them in a buffer and sending each one to the printer when the printer is able to process
it?
Options :



1.  Pool
2.  Spooler
3.  Drivers
4.  Operating system
  
Question Number : 17 Question Id : 2549899586 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा एक कं�ूटर �ो�ाम, ि�ंट जॉब को बफर म� अ�ायी �प से �ोर करके अनु�िमत करता है और जब ि�ंटर इसे �ोसेस करने म� स�म होता है,
तब ��ेक को ि�ंटर तक भेजता है?
Options :
1.   पूल (Pool)

2.   �ूलर (Spooler)

3.   ड� ाइवस� (Drivers)

4.   ऑपरेिटंग िस�म (Operating system)
  
Question Number : 18 Question Id : 25498910970 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which protocol is used for assigning IP Address in a network dynamically?
Options :
1.  Network server
2.  SMTP
3.  DHCP
4.  POP3
  
Question Number : 18 Question Id : 25498910970 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िकसी नेटवक�  म� गितशील �प से (dynamically) IP एड� ेस असाइन करने के िलए िकस �ोटोकॉल का उपयोग िकया जाता है?
Options :
1.  नेटवक�  सव�र



2.  SMTP
3.  DHCP
4.  POP3
  
Question Number : 19 Question Id : 25498911149 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a keyboard short cut to select a column in an MS-Excel 2019 worksheet?
Options :
1.  Alt + Spacebar
2.  Ctrl + Spacebar
3.  Shift + Spacebar
4.  Caps Lock + Spacebar
  
Question Number : 19 Question Id : 25498911149 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस-ए�ेल 2019  (MS-Excel 2019) वक� शीट म�, िकसी कॉलम को सेले� करने के िलए िन�िल�खत म� से िकस कीबोड� शॉट�कट का उपयोग िकया जाता है?
Options :
1.  Alt + �ेसबार
2.  Ctrl + �ेसबार
3.  Shift + �ेसबार
4.  Caps Lock + �ेसबार
  
Question Number : 20 Question Id : 25498913513 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
With reference to reducing the number of bytes consumed by large files in computers, Codec stands for ____________.
Options :
1.  compression/decompression
2.  encoder/decoder
3.  enhancer/de-enhancer



4.  sampler/de-sampler
  
Question Number : 20 Question Id : 25498913513 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कं�ूटस� म� बड़ी फाइलो ं�ारा कं�ूम की जाने वाली बाइट्स की सं�ा को कम करने के संदभ� म�, कोडेक (Codec) का ता�य� ____________ है।
Options :
1.  क�ेशन/डीक�ेशन (compression/decompression)

2.  एनकोडर/िडकोडर (encoder/decoder)

3.  ए��सर/डी-ए��सर (enhancer/de-enhancer)

4.  सै�लर/डी-सै�लर (sampler/de-sampler)
  
Question Number : 21 Question Id : 25498913612 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a type of media technology that delivers video and audio content to your Internet-connected device?
Options :
1.  Trimming
2.  Streaming
3.  Watching
4.  Quantizing
  
Question Number : 21 Question Id : 25498913612 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा, मीिडया टे�ोलॉजी का एक �कार है जो इंटरनेट से जुड़े िडवाइस पर वीिडयो और ऑिडयो कंट�ट िडलीवर करती है?
Options :
1.   िट� िमंग (Trimming)

2.   �� ीिमंग (Streaming)

3.   वॉिचंग (Watching)

4.   �ानटाईिज़ंग (Quantizing)



  
Question Number : 22 Question Id : 25498918570 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following types of installation is done when you don't want to upgrade from existing Windows?
Options :
1.  Clean
2.  Upgrade
3.  Uninstall
4.  Unclean
  
Question Number : 22 Question Id : 25498918570 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब आप मौजूदा िवंडोज से अप�ेड नही ंकरना चाहते ह�, तो िन�िल�खत म� से कौन-सा इं�ॉलेशन िकया जाता है?
Options :
1.  �ीन (Clean)

2.  अप�ेड (Upgrade)

3.  अनइं�ाल (Uninstall)

4.  अन�ीन (Unclean)
  
Question Number : 23 Question Id : 25498918580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What does IPv6 stand for?
Options :
1.  Internet Protocol version 6
2.  Internet Protocol verification 6
3.  Internet Product version 6
4.  Internet Protocol validation 6
  
Question Number : 23 Question Id : 25498918580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes



Correct Marks : 1 Wrong Marks : 0
IPv6 का पूण� �प �ा है?
Options :
1.  Internet Protocol version 6 (इंटरनेट �ोटोकॉल वज़�न 6)

2.  Internet Protocol verification 6 (इंटरनेट �ोटोकॉल वे�रिफकेशन 6)

3.  Internet Product version 6 (इंटरनेट �ोड� वज़�न 6)

4.  Internet Protocol validation 6 (इंटरनेट �ोटोकॉल वैिलडेशन 6
  
Question Number : 24 Question Id : 25498922668 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
If the MBR of your system is corrupted, which tool can recover it and boot Windows 10 normally?
Options :
1.  Bootos.exe
2.  Bootmbr.exe
3.  Bootrec.exe
4.  Booting.exe
  
Question Number : 24 Question Id : 25498922668 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
यिद आपके िस�म का MBR कर� हो गया है, तो िन�िल�खत म� से कौन-सा टूल इसे �रकवर कर सकता है और िवंडोज 10 (Windows 10) को सामा� �प से बूट कर
सकता है?
Options :
1.  Bootos.exe
2.  Bootmbr.exe
3.  Bootrec.exe
4.  Booting.exe
  
Question Number : 25 Question Id : 25498924031 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



How is the icon of a Desktop folder changed in Windows 10?
Options :
1.  Right click -> Properties-> General -> Folder option
2.  Right click -> Properties -> General -> Folder Pictures
3.  Right click on folder -> Properties -> Customize -> Folder icons
4.  Right click -> Properties -> General -> Advanced
  
Question Number : 25 Question Id : 25498924031 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िवंडोज 10 (Windows 10) म�, डे�टॉप फ़ो�र का आइकन कैसे बदला जाता है?
Options :
1.  राइट ��क-> �ोपट�ज-> जनरल-> फो�र ऑ�शन
2.  राइट ��क-> �ोपट�ज-> जनरल-> फो�र िप�स�
3.  फ़ो�र पर राइट ��क कर�  -> �ोपट�ज-> क�माइज-> फो�र आएको�
4.  राइट ��क-> �ोपट�ज-> जनरल-> एडवां�ड
  
Question Number : 26 Question Id : 25498924322 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keep(s) the track of files and directories in Operating System?
Options :
1.  File system
2.  Kernel
3.  Commands
4.  User interface
  
Question Number : 26 Question Id : 25498924322 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा, ऑपरेिटंग िस�म म� फाइलो ंऔर डायरे�रीज का ट� ैक रखता है?
Options :



1.  फाइल िस�म
2.  कन�ल
3.  कमा�
4.  यूज़र इ�रफ़ेस
  
Question Number : 27 Question Id : 25498924496 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the file extension of Rich Text Format files?
Options :
1.  .rt
2.  .rtf
3.  .rtfs
4.  .rtes
  
Question Number : 27 Question Id : 25498924496 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
�रच टे� फ़ॉम�ट (Rich Text Format) फ़ाइलो ंका फ़ाइल ए�ट�शन �ा है?
Options :
1.  .rt
2.  .rtf
3.  .rtfs
4.  .rtes
  
Question Number : 28 Question Id : 25498925354 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In sleep mode, the ________.
Options :
1.  current state of the computer is saved on a hard disk
2.  current state of the computer is saved on a digital versatile disk



3.  current state of the computer is saved on Random Access Memory
4.  current state of the computer is saved on a compact disk
  
Question Number : 28 Question Id : 25498925354 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
�ीप मोड (sleep mode) म�, कं�ूटर की वत�मान ��ित कहाँ सेव की जाती है?
Options :
1.  हाड� िड� पर
2.  डीिजटल वस�टायल िड� पर
3.  र�डम ए�ेस मेमोरी पर
4.  कॉ�ै� िड� पर
  
Question Number : 29 Question Id : 25498940415 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
To edit the content of a cell in MS-Excel 2019, press the _________ key after selecting the cell.
Options :
1.  F1
2.  F2
3.  F3
4.  F4
  



Question Number : 29 Question Id : 25498940415 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
 MS-Excel 2019 म�, सेल के कंट�ट को एिडट करने के िलए, सेल को सेले� करने के बाद _________ कंुजी दबाएं।
Options :
1.  F1
2.  F2
3.  F3
4.  F4
  
Question Number : 30 Question Id : 25498940556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the purpose of test completion criteria in a test plan?
Options :
1.  To set the criteria used in generating the test inputs.
2.  It is a checklist which need to be satisfied so that the software is considered ready to be released to the production environment.
3.  To know when the test planning is complete.
4.  To ensure that the test case specification is complete.
  
Question Number : 30 Question Id : 25498940556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
परी�ण योजना (test plan) म� परी�ण पूरा करने के मानदंड का �ा उ�े� है?
Options :
1.  परी�ण इनपुट उ�� करने म� �यु� मानदंडो ंको सेट करने के िलए।
2.  यह एक चेकिल� है िजसे पूरा करना आव�क है तािक सॉ�वेयर को �ोड�न एनवायरनम�ट म� �रलीज़ करने के िलए तैयार माना जा सके।
3.  यह जानने के िलए िक परी�ण योजना कब पूरी हो गई है।
4.  यह सुिनि�त करने के िलए िक परी�ण �करण िविनद�श (test case specification) पूरा हो गया है।
  
Question Number : 31 Question Id : 2549896777 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



The _______ protocol is used for uploading files on the server.
Options :
1.  World Wide Web (www)
2.  Hypertext Markup Language (HTML)
3.  Dynamic Host Control Protocol (DHCP)
4.  File Transfer Protocol (FTP)
  
Question Number : 31 Question Id : 2549896777 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
सव�र पर फ़ाइल� अपलोड करने के िलए _______ �ोटोकॉल का उपयोग िकया जाता है।
Options :
1.  व�� वाइड वेब (www)

2.  हाइपरटे� माक� अप ल��ेज (HTML)

3.  डायनेिमक हो� कंट� ोल �ोटोकॉल (DHCP)

4.  फाइल ट� ांसफर �ोटोकॉल (FTP)
  
Question Number : 32 Question Id : 2549899069 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What will happen when the formula “=COUNTIF(A1:A7,"????s")” is executed in MS-Excel 2016?
Options :
1.  It will count the number of cells that have exactly 5 characters, and end with the letter "s" in cells A1 through A7.
2.  It will count the number of cells that have exactly 7 characters, and end with the letter "s" in cells A1 through A7.
3.  It will count the number of cells that have exactly 5 characters, and end with the letter "s" in cell A1.
4.  It will count the number of cells that have exactly 5 characters, and end with the letter "s" in cell A7.
  
Question Number : 32 Question Id : 2549899069 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब MS-Excel 2016 म� सू� "=COUNTIF(A1:A7,"????s")" िन�ािदत िकया जाता है तो �ा होगा?
Options :



1.  यह उन सेलो ं(cells) की सं�ा की गणना करेगा िजनम� ठीक 5 कैरे�र ह�, और सेलो ंA1 से A7 म� अ�र "s" के साथ समा� होती ह�।
2.  यह उन सेलो ं(cells) की सं�ा की गणना करेगा िजनम� ठीक 7 कैरे�र ह�, और सेलो ंA1 से A7 म� अ�र "s" के साथ समा� होती ह�।
3.  यह उन सेलो ं(cells) की सं�ा की गणना करेगा िजनम� ठीक 5 कैरे�र ह�, और सेल A1 म� अ�र "s" के साथ समा� होती है।
4.  यह उन सेलो ं(cells) की सं�ा की गणना करेगा िजनम� ठीक 5 कैरे�र ह�, और सेल A7 म� अ�र "s" के साथ समा� होती है।
  
Question Number : 33 Question Id : 2549899147 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A user has to enter _______ to navigate any website.
Options :
1.  PPT
2.  URL
3.  WWW
4.  HTML
  
Question Number : 33 Question Id : 2549899147 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िकसी भी वेबसाइट पर नेिवगेट करने के िलए उपयोगकता� को _____ �िव� (enter) करना होगा।
Options :
1.  PPT
2.  URL
3.  WWW
4.  HTML
  
Question Number : 34 Question Id : 25498911071 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
State whether the given statements related to MS-Excel 2019 are true or false.

(i) The ribbon is located at the top of the screen and stretches across the window.
(ii) The Home tab displays a variety of tools and features used to format and move text.
Options :



1.  (i) False (ii) True
2.  (i) False (ii) False
3.  (i) True (ii) True
4.  (i) True (ii) False

  
Question Number : 34 Question Id : 25498911071 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
बताएं िक MS-Excel 2019 से संबंिधत िदए गए कथन स� ह� या अस�।
 
(i) �रबन (ribbon), �ीन के शीष� पर ��त होता है और पूरे िवंडो (window) म� फैला होता है।
(ii) Home टैब, टे� को फॉम�ट और �ानांत�रत करने के िलए �यु� िकए जाने वाले िविभ� �कार के टूल और फीचस� को �दिश�त करता है।
Options :
1.  (i) अस� (ii) स�
2.  (i) अस� (ii) अस�
3.  (i) स� (ii) स�
4.  (i) स� (ii) अस�
  
Question Number : 35 Question Id : 25498911899 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS-Word 2019, which view displays the original document without tracked changes and comments showing? However, any tracked changes or
comments in the document that have not been accepted, rejected, or deleted remain in the document.
Options :
1.  Final Showing Markup
2.  Final
3.  Original
4.  Original Showing Markup
  
Question Number : 35 Question Id : 25498911899 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



MS-Word 2019 म� कौन-सा �ू (view), ट� ै�ड च�जेस (tracked changes) और कम�ट्स को िदखाए िबना मूल डॉ�ूम�ट को �दिश�त करता है? हालाँिक, डॉ�ूम�ट म� कोई भी
ट� ै�ड च�जेस या कम�ट्स िज�� �ीकार, अ�ीकार या िडलीट नही ंिकया गया है, वे डॉ�ूम�ट म� ही रहते ह�।
Options :
1.  फाइनल शोिवंग माक� अप (Final Showing Markup)

2.  फाइनल (Final)

3.  ओ�रिजनल (Original)

4.  ओ�रिजनल शोिवंग माक� अप (Original Showing Markup)
  
Question Number : 36 Question Id : 25498924650 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following formulas when executed will give an error in MS-Excel 2019?
Options :

1.  

2.  

3.  

4.  

  
Question Number : 36 Question Id : 25498924650 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 म�, िन�िल�खत म� से कौन-सा सू� िन�ािदत होने पर �ुिट देगा?
Options :

1.  



2.  

3.  

4.  

  
Question Number : 37 Question Id : 25498924655 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the keyboard shortcut for justified alignment in MS-Word 2019?
Options :
1.  Ctrl + R
2.  Ctrl + J
3.  Ctrl + T
4.  Ctrl + L
  
Question Number : 37 Question Id : 25498924655 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 म�, ज��फाइड अलाइनम�ट के िलए िकस कीबोड� शॉट�कट का उपयोग िकया जाता है?
Options :
1.  Ctrl+ R
2.  Ctrl+ J
3.  Ctrl+ T
4.  Ctrl+ L
  
Question Number : 38 Question Id : 25498924665 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What do you understand by the term 'tabs' in the context of MS-Word 2010?
Options :



1.  Tabs are not embedded in your document’s text
2.  Tabs are hidden formatting characters, similar to space characters
3.  Tabs are hidden formatting characters, but are not similar to space characters
4.  Tabs are viewable formatting characters
  
Question Number : 38 Question Id : 25498924665 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2010 के संदभ� म� 'टैब (tabs)' श� से आप �ा समझते ह�?
Options :
1.  टैब, आपके डॉ�ूम�ट के टे� म� ए�ेडेड नही ंहोते ह�।
2.  �ेस करै�र (space characters) के समान, टैब छुपे �ए (hidden) फॉम��िटंग करै�र होते ह�।
3.  टैब छुपे �ए फॉम��िटंग करै�र होते ह�, परंतु �ेस करै�र के समान नही ंहोते ह�।
4.  टैब, िदखाई देने वाले (viewable) फॉम��िटंग करै�र होते ह�।
  
Question Number : 39 Question Id : 25498925223 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
FTP is used for ______.
Options :
1.  only downloading files
2.  only uploading files
3.  merging files
4.  transferring files between hosts over internet
  
Question Number : 39 Question Id : 25498925223 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
FTP का उपयोग ____________ िकया जाता है।
Options :
1.  केवल फाइलो ंको डाउनलोड करने के िलए



2.  केवल फाइलो ंको अपलोड करने के िलए
3.  फाइलो ंको मज� करने के िलए
4.  इंटरनेट पर हो� (hosts) के बीच फाइलो ंको �ानांत�रत करने के िलए
  
Question Number : 40 Question Id : 25498925286 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What do you understand by file naming convention?
Options :
1.  A framework for naming your files.
2.  A framework which helps in transferring data from one file to another.
3.  A framework which does not relate to other files.
4.  A framework which describes how files are unrelated to other files.
  
Question Number : 40 Question Id : 25498925286 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
फ़ाइल नामकरण प�रपाटी (convention) से आप �ा समझते ह�?
Options :
1.  अपनी फाइलो ंका नामकरण करने के िलए एक �ेमवक�
2.  एक �ेमवक� , जो डेटा को एक फ़ाइल से दूसरे म� �ानांत�रत करने म� मदद करता है
3.  एक �ेमवक� , जो अ� फाइलो ंसे संबंिधत नही ंहै
4.  एक �ेमवक� , जो वण�न करता है िक फाइल� अ� फाइलो ंसे कैसे संबंिधत नही ंह�
  
Question Number : 41 Question Id : 25498925329 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
If the width of the page is less than the height of the page in an MS-Word document then which of the following statements would be FALSE?
Options :
1.  The page orientation is Landscape.
2.  The page orientation is in Default.



3.  The page orientation is Portrait.
4.  The page is vertically aligned.
  
Question Number : 41 Question Id : 25498925329 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
यिद MS-Word डॉ�ूम�ट म�, पेज की चौड़ाई पेज की ऊंचाई से कम है, तो िन�िल�खत म� से कौन-सा कथन गलत होगा?
Options :
1.  पेज ओ�रएंटेशन ल�ड�ेप है।
2.  पेज ओ�रएंटेशन िडफ़ॉ� म� है।
3.  पेज ओ�रएंटेशन पोट� �ट है।
4.  पेज, विट�कली अलाइ� है।
  
Question Number : 42 Question Id : 25498938399 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the process in which a preferred version of a page is selected over multiple other versions when searching for webpages?
Options :
1.  URL modification
2.  URL support
3.  URL balancing
4.  Canonicalization
  
Question Number : 42 Question Id : 25498938399 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
वह कौन-सी �ि�या है िजसम� वेबपेजो ंकी खोज करते समय एक पेज के पसंदीदा वज�न (preferred version) को कई अ� वज�नो ंकी तुलना म� चुना जाता है?
Options :
1.  URL मॉिडिफकेशन (URL modification)
2.  URL सपोट� (URL support)
3.  URL बैल��िसंग (URL balancing)



4.  कैनॉिनकलाइज़ेशन (Canonicalization)
  
Question Number : 43 Question Id : 25498938402 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Replacing an IP address (http://208.77.188.166/) with a domain name (http://www.example.com/) is a ___________process.
Options :
1.  URL support
2.  DNS Resolution
3.  URL balancing
4.  URL modification
  
Question Number : 43 Question Id : 25498938402 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक IP एड� ेस (http://208.77.188.166/) को डोमेन नाम (http://www.example.com/) से बदलना, एक ___________ �ि�या है।
Options :
1.  URL सपोट� (URL support)

2.  DNS रेजो�ूशन (DNS Resolution)

3.  URL बैल��िसंग (URL balancing)

4.  URL मॉिडिफकेशन (URL modification)
  
Question Number : 44 Question Id : 25498941583 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following text functions of MS-Excel 2019 is used to join two or more text strings into one string?
Options :
1.  CONCATENATE
2.  JOIN
3.  MERGE
4.  COMBINE
  



Question Number : 44 Question Id : 25498941583 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 के िन�िल�खत म� से िकस टे� फ़ं�न का उपयोग दो या दो से अिधक टे� ��� ं� को एक ��� ंग म� जोड़ने के िलए िकया जाता है?
Options :
1.  कोनकैटीनेट (CONCATENATE)

2.  �ाइन (JOIN)

3.  मज� (MERGE)

4.  कंबाइन (COMBINE)
  
Question Number : 45 Question Id : 25498941588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_______ is the logical function used in MS-Excel.
Options :
1.  IF()
2.  VLOOKUP()
3.  SQRT()
4.  DATEVALUE()
  
Question Number : 45 Question Id : 25498941588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
 ________, MS-Excel म� �यु� िकया जाने वाला लॉिजकल फं�न है।
Options :
1.  IF()
2.  VLOOKUP()
3.  SQRT()
4.  DATEVALUE()
  
Question Number : 46 Question Id : 25498941602 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



In MS-Excel 2019, after pressing F4 key twice, the cell reference changes from A1 to _______.
Options :
1.  absolute reference ($A$1)
2.  absolute row reference (A$1) 
3.  relative reference (A1)
4.  absolute column reference ($A1)
  
Question Number : 46 Question Id : 25498941602 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 म�, F4 कंुजी को दो बार दबाने के बाद, सेल संदभ� (cell reference) A1 से ________ म� बदल जाती है।
Options :
1.  िनरपे� संदभ� ($A$1) [absolute reference($A$1)]
2.  िनरपे� पं�� संदभ� (A$1) [absolute row reference(A$1)]
3.  सापे� संदभ� (A1) [relative reference(A1)]
4.  िनरपे� �ंभ संदभ� ($A1) [absolute column reference($A1)]
  
Question Number : 47 Question Id : 25498941605 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS-Excel, a/an _______ is an action or a set of actions that you record and can run as many times as you want.
Options :
1.  micro
2.  macro
3.  trigger
4.  entity
  
Question Number : 47 Question Id : 25498941605 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel म� __________ एक ए�न या ए�� का एक समूह है िजसे आप �रकॉड� करते ह� और िजतनी बार चाह� उतनी बार उसे रन (run) कर सकते ह�।
Options :



1.  माइ�ो (micro)

2.  मै�ो (macro)

3.  िट� गर (trigger)

4.  एंिटटी (entity)
  
Question Number : 48 Question Id : 25498941608 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Identify the sequence of steps used in MS-Excel 365 to enable the Developer tab.
Options :
1.  Insert -> Options -> Customize Ribbon
2.  File -> Options -> Customize Ribbon
3.  Design -> Options -> Customize Ribbon
4.  View -> Options -> Customize Ribbon
  
Question Number : 48 Question Id : 25498941608 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
डेवलपर टैब को एनेबल (enable) करने के िलए MS-Excel 365 म� उपयोग िकए जाने वाले चरणो ंके अनु�म (सी�� स) की पहचान कर�।
Options :
1.  इ�ट� -> ऑ�शंस -> क�माइज़ �रबन (Insert -> Options -> Customize Ribbon)

2.  फाइल -> ऑ�शंस -> क�माइज़ �रबन (File -> Options -> Customize Ribbon)

3.  िडज़ाइन -> ऑ�शंस -> क�माइज़ �रबन (Design -> Options -> Customize Ribbon)

4.  �ू -> ऑ�शंस -> क�माइज़ �रबन (View -> Options -> Customize Ribbon)
  
Question Number : 49 Question Id : 25498941629 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The ASCII value of decimal 5 is _______.
Options :
1.  57



2.  97
3.  53
4.  65
  
Question Number : 49 Question Id : 25498941629 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
डेसीमल 5 का ASCII मान _______ है।
Options :
1.  57
2.  97
3.  53
4.  65
  
Question Number : 50 Question Id : 25498941633 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The hexadecimal equivalent of decimal 10 is _______.
Options :
1.  A
2.  B
3.  C
4.  D
  
Question Number : 50 Question Id : 25498941633 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दशमलव सं�ा (decimal number) 10 का हे�ाडेिसमल समतु� (hexadecimal equivalent) _______ है।
Options :
1.  A
2.  B
3.  C



4.  D
  
Question Number : 51 Question Id : 25498941649 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The octal equivalent of decimal number 15 is _______.
Options :
1.  12
2.  17
3.  15
4.  14
  
Question Number : 51 Question Id : 25498941649 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दशमलव अंक (डेिसमल) 15 का अ�क समतु� (ऑ�ल एि�वैले�) _______ है।
Options :
1.  12
2.  17
3.  15
4.  14
  
Question Number : 52 Question Id : 25498941653 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which function of MS-Excel 2019 returns TRUE if any argument is TRUE?
Options :
1.  AND
2.  NOT
3.  OR
4.  AT
  



Question Number : 52 Question Id : 25498941653 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Ms-Excel 2019 का कौन-सा फ़ं�न, िकसी भी आगु�म�ट के TRUE होने पर TRUE लौटाता है?
Options :
1.  AND
2.  NOT
3.  OR
4.  AT
  
  

READING COMPREHENSION
Section Id : 2549898480
Section Number : 2
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 5
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898521
Question Shuffling Allowed : No
  
Question Id : 25498921379 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension Questions : No
Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
Read the given passage and answer the questions.

Marco Polo lived in Venice, Italy. He was just a boy of seventeen and not very strong when he set out on his travels. He left for China in 1271 along with his
father and uncle. They had to go over the mountains, across terrible deserts, through hot burning lands and places where it was freezing cold. At times,
Marco was ill on account of the hard and dangerous journey but he got better and kept moving on bravely. It took them three years to reach China where



Kublai Khan, the king of China welcomed them.

Marco Polo grew up at the Chinese court and became a great favourite of the king. He learnt to speak several languages. He was so clever that the king sent
him to India and other lands as his ambassador. Each time when he returned he had lots of things to tell the king – about the places he had visited, how the
people lived there, what their trades were and what messages they sent for the king. Kublai Khan was so happy with the information that he heaped riches
on Marco Polo.

The Polos were happy in China but they longed to return to Venice. It was 1295 when the three travellers returned to Venice. Their clothes were tattered and
they spoke a strange language. Nobody recognised them for they had been away so long. Even their family had given them up for dead. Marco was now a
middle-aged man. He told the people wonderful things about China. The Chinese, he said, did not write books with their hands. They printed many books at
a time. They used clocks powered by water to tell the time. They made colourful fireworks from a strange thing called gunpowder.

At that time in Italy, no one had heard about gunpowder, printing or clocks. They thought the three men were mad. In order to prove who they were, Marco
Polo cut open the patches in his clothes and to everyone’s surprise, out fell diamonds, rubies, pearls and sapphires. People were amazed to see such
treasures. Now they believed that the strangers were really the Polos back from a marvellous journey.
Sub questions
 
Question Number : 53 Question Id : 25498921380 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What was the destination of the Polos?
Options :
1.  Venice
2.  India
3.  China
4.  Italy
 
Question Number : 54 Question Id : 25498921381 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Kublai Khan gave precious gifts to Marco Polo because:
Options :
1.  he could speak several languages
2.  he visited far-away lands
3.  he worked as an ambassador



4.  he gave valuable information to the king
 
Question Number : 55 Question Id : 25498921382 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The Polos had been away from home for:
Options :
1.  22 years
2.  23 years
3.  24 years
4.  25 years
 
Question Number : 56 Question Id : 25498921383 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is FALSE as per the given passage?
Options :
1.  The Chinese printed their books.
2.  The Chinese used electric clocks.
3.  The Chinese invented gunpowder.
4.  The Chinese made colourful fireworks.
 
Question Number : 57 Question Id : 25498921384 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What ultimately proved the identity of the Polos?
Options :
1.  They spoke in Chinese.
2.  They possessed precious gems.
3.  They wore tattered clothes.
4.  They told strange tales.
  



Question Id : 25498921379 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension Questions : No
Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
िदए गए ग�ांश को पढ़�  और उसके आधार पर ��ो ंके उ�र द�।

माक� पोलो वेिनस, इटली म� रहता था। वह तब िसफ�  स�ह वष� का एक लड़का था, जब उसने अपनी या�ाएँ �ारंभ की ंऔर तब वह ब�त मजबूत नही ंथा। वह 1271 म� अपने
िपता और चाचा के साथ चीन के िलए रवाना �आ। उ�� पहाड़ो ंके ऊपर, भयानक रेिग�ानो ंके पार, गम� जलती भूिमयो ंऔर उन �ानो ंसे होकर जाना पड़ा जहाँ जमा देने
वाली ठंड थी। कई बार किठन और खतरनाक या�ा के कारण माक� बीमार पड़ जाता, लेिकन वह बेहतर हो जाता और बहादुरी से आगे बढ़ता रहता। चीन प�ँचने म� उ��
तीन साल लगे, जहाँ चीन के राजा कुबलई खान ने उनका �ागत िकया।

माक� पोलो चीनी राज दरबार म� बड़ा �आ और राजा का पसंदीदा बन गया। उसने कई भाषाएँ बोलनी सीखी। वह इतना चतुर था िक राजा ने उसे भारत और अ� देशो ंम�
अपने राजदूत के �प म� भेजा। ��ेक बार जब वह लौटा तो राजा को बताने के िलए उसके पास उन �ानो ंके बारे म� ब�त सारी चीज� होती थी ंिजनका वह दौरा करता था –
जैसे, वहाँ लोग कैसे रहते थे, उनके �ा �ापार थे और उ�ों�ने राजा के िलए �ा संदेश भेजे। कुबलई खान इस जानकारी से इतना खुश था िक उसने माक� पोलो पर धन का
ढेर लगा िदया।

पोलो चीन म� खुश थे लेिकन वे वेिनस लौटने के िलए उ�ुक थे। यह 1295 था जब तीनो ंया�ी वेिनस लौटे। उनके कपड़े फटे �ए थे और वे अजीब भाषा बोलते थे। िकसी ने
उ�� नही ंपहचाना �ों�िक वे इतने समय से दूर थे। यहां तक िक उनके प�रवार ने उ�� मरा �आ समझकर छोड़ िदया था। माक� अब एक अधेड़ उ� का आदमी था। उ�ों�ने
लोगो ंको चीन के बारे म� अद्भुत बात� बताईं। उसने कहा, चीनी अपने हाथो ंसे िकताब� नही ंिलखते। उ�ों�ने एक समय म� कई पु�क�  छापी।ं वे समय बताने के िलए पानी से
चलने वाली घिड़यो ंका उपयोग करते थे। उ�ों�ने बा�द नामक एक अजीब चीज़ से रंगीन आितशबाज़ी बनाई।

उस समय इटली म�, िकसी ने गनपाउडर (बा�द), ि�ंिटंग या घिड़यो ंके बारे म� नही ंसुना था। उ�ों�ने सोचा िक तीन पु�ष पागल थे। यह िस� करने के िलए िक वे कौन थे,
माक� पोलो ने अपने कपड़ो ंम� पैच खोल िदए और हर िकसी को आ�य�चिकत करते �ए, हीरे, �बी, मोती और नीलमिण नीचे िगरा िदए। ऐसे खजाने को देखकर लोग
आ�य�चिकत �ए। अब उ�ों�ने िव�ास िकया िक अजनबी वा�व म� एक अद्भुत या�ा से वापस लौटे, पोलो लोग थे।
Sub questions
 
Question Number : 53 Question Id : 25498921380 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
पोलो का गंत� �ा था?
Options :
1.  वेिनस
2.  भारत
3.  चीन
4.  इटली



 
Question Number : 54 Question Id : 25498921381 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कुबलई खान ने माक� पोलो को ब�मू� उपहार िदए �ों�िक:
Options :
1.  वह कई भाषाएँ बोल सकता था।
2.  उसने दूर देशो ंका दौरा िकया।
3.  उसने एक राजदूत के �प म� काय� िकया।
4.  उसने राजा को मू�वान जानकारी दी।
 
Question Number : 55 Question Id : 25498921382 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
पोलो घर से िकतने वष� दूर रहा था?
Options :
1.  22 वष�
2.  23 वष�
3.  24 वष�
4.  25 वष�
 
Question Number : 56 Question Id : 25498921383 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िदए गए ग�ांश के अनुसार इनम� से कौन-सा कथन गलत है?
Options :
1.  चीिनयो ंने अपनी िकताब� मुि�त की।ं
2.  चीिनयो ंने िबजली की घिड़यो ंका उपयोग िकया।
3.  चीिनयो ंने गनपाउडर (बा�द) का आिव�ार िकया।
4.  चीिनयो ंने रंगीन आितशबाजी िनिम�त की।
 
Question Number : 57 Question Id : 25498921384 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes



Correct Marks : 1 Wrong Marks : 0
आ�खरकार पोलो लोगो ंकी पहचान िकससे िस� �ई?
Options :
1.  उ�ों�ने चीनी भाषा बोली।
2.  उनके पास कीमती र� थे।
3.  वे फटे �ए कपड़े पहने थे।
4.  उ�ों�ने िविच� कहािनयां सुनाईं।
  
  

QUANTITATIVE APTITUDE
Section Id : 2549898481
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898522
Question Shuffling Allowed : Yes
  
Question Number : 58 Question Id : 25498928823 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What approximate value should come in place of the question mark (?) in the following equation?

Options :



1.  12
2.  15
3.  24
4.  21
  
Question Number : 58 Question Id : 25498928823 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत समीकरण (Equation) म� �� िच� (?) के �ान पर �ा अनुमािनत मान आना चािहए?

Options :
1.  12
2.  15
3.  24
4.  21
  
Question Number : 59 Question Id : 25498928974 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :
1.  459
2.  486
3.  468
4.  450
  
Question Number : 59 Question Id : 25498928974 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes



Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 60 Question Id : 25498929078 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What will come in place of the question mark (?) in the following number series?

155 151 144 132 113 ?
Options :
1.  89
2.  71
3.  85
4.  92
  
Question Number : 60 Question Id : 25498929078 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



Options :

1.  

2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498929133 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The number of teachers in universities A, B, C, D, E and F are 704, 1088, 1216, 384, 1856 and 1152, respectively. What is the average number of teachers in
University A, University C, University D and University F together?
Options :
1.  854
2.  3546
3.  3456
4.  864
  
Question Number : 61 Question Id : 25498929133 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



Options :
1.  854
2.  3546
3.  3456
4.  864
  
Question Number : 62 Question Id : 25498929554 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  3
4.  1
  
Question Number : 62 Question Id : 25498929554 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :



1.  

2.  

3.  

4.  

  
Question Number : 63 Question Id : 25498929634 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In x litres of solution of alcohol and water, the ratio of alcohol to water is 5 : 3. When 8 litres of the solution is taken out and replaced with water, the ratio of
alcohol and water is 1 : 1. The value of x is:
Options :
1.  32
2.  36
3.  40
4.  60
  



Question Number : 63 Question Id : 25498929634 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अ�ोहल और जल के x लीटर िवलयन म� अ�ोहल और जल का अनुपात 5 : 3 है। जब इसम� से 8 लीटर िवलयन को जल से बदल िदया जाता है, तो अ�ोहल और जल
का अनुपात 1 : 1 हो जाता है। x का मान �ा होगा?
Options :
1.  32
2.  36
3.  40
4.  60
  
  

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549898482
Section Number : 4
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898523
Question Shuffling Allowed : Yes
  
Question Number : 64 Question Id : 25498910160 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Happiness' is related to 'Sorrow' in the same way as 'Comfort' is related to '_________'.
Options :
1.  Hardship



2.  Rest
3.  Poverty
4.  Difficulty
  
Question Number : 64 Question Id : 25498910160 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'�स�ता' का 'दुख' से वही संबंध है, जो संबंध 'आराम' का ________ से है।
Options :
1.  क�
2.  िव�ाम
3.  िनध�नता
4.  किठनाई
  
Question Number : 65 Question Id : 25498912946 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :
1.  1, 2, 6, 4, 3, 5
2.  4, 2, 6, 5, 3, 1
3.  5, 3, 6, 4, 2, 1
4.  6, 3, 1, 4, 2, 5
  
Question Number : 65 Question Id : 25498912946 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



Options :
1.  1, 2, 6, 4, 3, 5
2.  4, 2, 6, 5, 3, 1
3.  5, 3, 6, 4, 2, 1
4.  6, 3, 1, 4, 2, 5
  
Question Number : 66 Question Id : 25498919014 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the word from the options that is similar to the given set of words in a certain way and hence belongs to the same group.

Basket : Pail : Pan
Options :
1.  Spoon
2.  Bowl
3.  Fork
4.  Knife
  
Question Number : 66 Question Id : 25498919014 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िवक�ो ंम� से वह श� चुिनए जो िकसी िनि�त तरीके से िदए गए श�ो ंके समूह के समान है और इसिलए उसी समूह से संबंिधत है।
 
टोकरी : डोल : पैन
Options :
1.  च�च
2.  कटोरी



3.  काँटा
4.  चाकू
  
Question Number : 67 Question Id : 25498919636 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the most appropriate description about the given set of words.

Colorado : Seine : Volga
Options :
1.  Ports
2.  Rivers
3.  Lakes
4.  Harbours
  
Question Number : 67 Question Id : 25498919636 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
श�ो ंके िदए गए समूह के बारे म� सबसे उपयु� िववरण का चयन कर�।

कोलोराडो : सीन : वो�ा
Options :
1.  बंदरगाह
2.  नदी
3.  झील
4.  हाब�र
  
Question Number : 68 Question Id : 25498919769 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the option that is true regarding the following two statements labelled Assertion (A) and Reason (R).

Assertion (A): Alcohol rather than mercury is used in a thermometer to measure a temperature of -60˚C.
Reason (R): Alcohol has a lower freezing point than mercury.



Options :
1.  Both A and R are true and R is the correct explanation of A.
2.  Both A and R are true but R is not the correct explanation of A.
3.  A is true but R is false.
4.  A is false but R is true.

  
Question Number : 68 Question Id : 25498919769 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
उस िवक� का चयन कीिजए जो अिभकथन (A) और कारण (R) नामक िन�िल�खत दो कथनो ंके संबंध म� स� है।

अिभकथन (A): -60˚C के तापमान को मापने के िलए पारे के �ान पर ऐ�ोहॉल का उपयोग थमा�मीटर म� िकया जाता है।
कारण (R): पारे की तुलना म� ऐ�ोहॉल का िहमांक िबंदु कम होता है।
Options :
1.  A और R दोनो ंस� ह� और R, A का सही ��ीकरण ह�।
2.  A और R दोनो ंस� ह� परंतु R, A का सही ��ीकरण नही ंह�।
3.  A स� है परंतु R अस� है।
4.  A अस� है परंतु R स� है।
  
Question Number : 69 Question Id : 25498927401 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :



1.  

2.  

3.  

4.  

  
Question Number : 69 Question Id : 25498927401 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



उस िवक� प का चयन कर�  जो नीचे �दिश�त िच� के अनुसार िबंदुओ ंके �ान-िनधा�रण की समान शत� को पूण� करता है।

Options :

1.  

2.  

3.  



4.  

  
  

GENERAL AWARENESS
Section Id : 2549898483
Section Number : 5
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898524
Question Shuffling Allowed : Yes
  
Question Number : 70 Question Id : 2549895308 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Certain regions of Tamil Nadu, Andhra Pradesh and Himachal Pradesh have rainy seasons from:
Options :
1.  September to January
2.  October to December
3.  December to March
4.  February to May



  
Question Number : 70 Question Id : 2549895308 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
तिमलनाडु, आं� �देश और िहमाचल �देश के कुछ िनि�त भागो ंम� वषा� ऋतु िकन महीनो ंके दौरान होती है?
Options :
1.  िसतंबर से जनवरी
2.  अ�ूबर से िदसंबर
3.  िदसंबर से माच�
4.  फरवरी से मई
  
Question Number : 71 Question Id : 25498912564 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following series is true about energy flow in an ecosystem?
Options :
1.  Producers → Decomposers → Consumers
2.  Decomposers → Consumers → Producers
3.  Producers → Consumers → Decomposers
4.  Consumers → Producers → Decomposers
  
Question Number : 71 Question Id : 25498912564 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
पा�र��ितकी तं� म� ऊजा� के �वाह के संबंध म� िन�िल�खत म� से कौन सा �म सही है?
Options :
1.  उ�ादक → अपघटक → उपभो�ा
2.  अपघटक → उपभो�ा → उ�ादक
3.  उ�ादक → उपभो�ा → अपघटक
4.  उपभो�ा → उ�ादक → अपघटक
  
Question Number : 72 Question Id : 25498912642 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes



Correct Marks : 1 Wrong Marks : 0
When one animal is used to suppress another, it is called ______. For example, if snakes are encouraged in an area, the rodent population will be controlled.
Options :
1.  technical control of pests
2.  pest control
3.  botanical control of pests
4.  biological control of pests

  
Question Number : 72 Question Id : 25498912642 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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एक जीव �ारा अ� जीवो ंको न� करना _____________ कहलाता है। उदाहरण के िलए, यिद िकसी �ान पर सांपो ंकी सं�ा बढ़ा दी जाए, तो वहां पर चूहो ंकी सं�ा
िनयंि�त हो जाएगी।
Options :
1.  कीटो ंका तकनीकी िनयं�ण
2.  कीट िनयं�ण
3.  कीटो ंका वान�ितक िनयं�ण
4.  कीटो ंका जैिवक िनयं�ण
  
Question Number : 73 Question Id : 25498922860 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Aristotle lantern is:
Options :
1.  a fresh water Echinodermata
2.  a toothed chewing apparatus found in sea urchin
3.  a circulatory system found in starfish
4.  a lantern like structure found in brittle star
  
Question Number : 73 Question Id : 25498922860 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0



ए�र�ोटल ल�टन� (Aristotle lantern) �ा है?
Options :
1.  एक �� जल का एिकनोडम�टा
2.  समु�ी जलसाही (urchin) म� पाई जाने वाली िविश� दंताविल
3.  तारा मछली म� पाया जाने वाला प�रसंचरण तं�
4.  भंगुर तारा (brittle star) म� पाई जाने वाली ल�टन� जैसी संरचना
  
Question Number : 74 Question Id : 25498932472 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following may be regarded as the first labour association in India?
Options :
1.  The Bombay Mill Hand’s Association
2.  The Bombay Worker’s Association
3.  The Indian Worker’s Association
4.  The Printer’s Union, Calcutta
  
Question Number : 74 Question Id : 25498932472 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से िकसे भारत का पहला �िमक संघ माना जाता है?
Options :
1.  द बॉ�े िमल ह�ड्स एसोिसएशन
2.  द बॉ�े वक� स� एसोिसएशन
3.  द इंिडयन वक� स� एसोिसएशन
4.  द ि�ंटस� यूिनयन, कलक�ा
  
Question Number : 75 Question Id : 25498932592 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The Right to equality is given under Article _______________________ of the Constitution of India.
Options :



1.  14
2.  15
3.  16
4.  17
  
Question Number : 75 Question Id : 25498932592 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
भारतीय संिवधान म� समानता का अिधकार अनु�ेद ________ के अंतग�त िदया गया है।
Options :
1.  14
2.  15
3.  16
4.  17
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Question Number : 76 Question Id : 25498946188 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork, socializing,
decision making, independent and responsible living and more. It aids the overall development of a child and children have fun during this process
as they get to explore new arenas.
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Question Number : 77 Question Id : 25498942567 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Corporate dressing refers to the art of dressing formally and correctly. Corporate dressing helps an individual to dress according to his work
profile and organization culture. If formal dressing is done correctly it goes a long way in shaping a personality of a person. People take you
seriously if you are dressed sensibly. Remember no one likes to speak to an individual who does not know how to carry themselves. Going to work
in formals helps you create an image of yours. Dressing correctly helps you stand apart from the rest and be a role model for others. Dressing
formally not only reflects your image but also the organization you represent. You need to follow a proper dress code at the workplace. An
individual just cannot afford to be casually dressed for important business meetings or presentations. Remember you are not only presenting
yourself but your organization. An individual who looks presentable is liked and appreciated by all. Someone who is formally and sensibly dressed
does not have to try too hard to impress a client. A marketing professional had to deliver a presentation about a new offering of his organistion.
This presentation was to happen at a clients office. He never really bothered about his dressing. He wore a pair of jeans teamed with a casual shirt
along with chunky bracelets and earrings. He even forgot to polish his shoes. As a result he As a result he was denied entry to the office. The lady
sitting at the reception refused to let him go inside the board room and meet the senior officials. This was not the fault of receptionist. This is really



not how one should be dressed for business meetings. No one will tell you what you have to wear to work daily. Do not step out of home unless you
see yourself in the mirror. Corporate dressing helps you develop a magnetic personality which attracts other individuals. You need to have that
charisma and dressing formally helps you in the same. Corporate dressing helps you inculcate a good and healthy culture at the workplace.
Individuals tend to lose interest in their work if they are not formally dressed. You really do not feel like working if you are dressed casually on a
Monday. Torn jeans and multiple chains are a strict no no in corporate settings as they spoil the decorum of the organization. Female employees
should avoid wearing chandelier earrings and stacks of bangles. There is absolutely no need of flaunting your gold jewellery at workplace.
Remember price has nothing to do with corporate dressing. You really do not need to burn a hole in your pocket to buy designer business suits.
Dress sensibly. Corporate dressing helps you flaunt your simple and clean yet elegant look. Corporate dressing helps you create that first
impression. Remember first impressions are important and they help you throughout your life. If you fail to impress someone in the first meeting
then you will never get a second chance to impress them. Formal dressing makes you feel confident at work. You get that energy and confidence.
The moment you wear your crisp white shirt along with a black trouser you have a different aura around you. Dress code makes an individual
disciplined and inculcates a sense of team spirit.
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एक बार की बात है, अकबर और बीरबल िशकार पर जा रहे थे। अभी कुछ समय की उ�� एक िहरण िदखा। ज�बाजी म� तीर िनकालते �ए अकबर अपने हाथ
पर घाव लगा बैठा। अब हालात कुछ ऐसे थे की अकबर ब�त दद� म� था और गु�े म� भी।
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कोलकाता भारत के बंगाल �देश की राजधानी है और भारत के �मुख महानगरो ंम� से एक है। कोलकाता �गली नदी के पूव� िकनारे व बंगाल की खाडी के शीष�
तट पर बसा �आ है। कोलकाता भारत का दूसरा सबसे बडा महानगर तथा पांचवा सबसे बडा बंदरगाह है। इस शहर का इितहास �ाचीन है। इसके आधुिनक
�प का िवकास अं�ेजी एवं �ांसीसी उपिनवेशवाद के इितहास से जुडा है। आज का कोलकाता आधुिनक भारत के इितहास की कई गाथाएं अपने आप म� समेटे
�ए है। यह नगर भारत के शैि�क प�रवत�नो ंकी शु�आत का क� � था। महलो ंके इस शहर को आनंद का शहर भी कहा जाता है। वायु माग� व सडक माग� तथा
रेल माग� के ज�रए यह देश के लगभग सभी भागो ंसे जुडा है। यह �मुख �प से िवदेश यातायात का क� � है। इसके अलावा यह बाजार िवतरण व कारोबार का भी
िवशाल क� � है। कोलकाता के िनकट �गली नदी के दोनो ंिकनारो ंपर भारतवष� के �ाय अिधकांश जूट के कारखाने मौजूद ह�। इसके अलावा यहां मोटरगाडी
तैयार करने के व सूती कपडा तैयार करने के और कागज तैयार करने वाले कारखानो ंके जैसे और भी कई बडे कारखाने ह�। इसी कारण ितजारत के अनुसार यह
भारत का �मुख क� � है। आिधका�रक �प से इस शहर का नाम कोलकाता एक जनवरी दो हजार एक को रखा गया। पहले इसका नाम अं�ेजी म� कैलकटा ही



था लेिकन बंगाली भाषाई लोग इसे सदा कोलकाता या कोिलकाता के नाम से ही जानते ह� एवं िहंदी भाषी समुदाय म� यह कलकता के नाम से जाना जाता रहा है।
सबसे �चिलत व लोकि�य कहानी के अनुसार िहंदुओ ंकी देवी काली के नाम के आधार पर इसम� कुछ अ�र और जोडकर इस शहर का नाम कोलकाता रखा
गया है। इस शहर के वजूद का वण�न ितजारत बंदरगाह के �प म� चीन के �ाचीन याि�यो ंके या�ा वृतांत और फारसी कारोबा�रयो ंके �लेखो ंम� भी िमलता है।
महाभारत की कथा म� भी बंगाल के कुछ राजाओ ंका नाम है जो कौरव सेना की तरफ से लडाई म� शािमल �ए थे। इस शहर के नाम की कहानी और िववाद चाहे
जो भी हो लेिकन इतना तो तय है िक यह आधुिनक भारत के शहरो ंम� सबसे पहले बसने वाले शहरो ंम� से एक है। सबसे पहले पूव� भारतीय कंपनी के एक
अिधकारी जाब चारनाक ने अपनी कंपनी के कारोबा�रयो ंके िलए यहां एक कसबा बसाया गया था। अगले साल इंगल�ड के राजा जाज� के आदेशानुसार यहां एक
नाग�रक अदालत भी बनाई गई थी। िफर जब कोलकाता नगर िनगम को बनाया गया तो उससे पहले वहां के मेयर का चुनाव िकया गया। इसके अलावा जब तक
भारत म� अं�ेजी शासन रहा तब तक भारत की राजधानी कोलकाता ही बनी रही। एक बार कोलकाता म� एक ब�त बडा समु�ी तूफान आया था िजसम� साठ
हजार से भी अिधक लोग मारे गए थे। हालांिक इस समु�ी तूफान की वजह से कोलकाता म� बुरी तरह तबाही �ई लेिकन इसके बावजूद कोलकाता अिधकांशत
अिनयोिजत �प से अगले डेढ सौ सालो ंम� बढता चला गया और आज इसकी आबादी लगभग एक करोड चालीस लाख है। एक समय था जब कोलकाता भारत
का सबसे अिधक आबादी वाला �े� था। लेिकन आज यह आबादी म� मंुबई के बाद दूसरे नंबर पर आता है। कोलकाता म� अनेक दाश�िनक जगह� ह� जो पल भर म�
आपका मन मोह ल�गी और आप उस शहर के होकर रह जाएंगे।
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